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DEAR CUSTOMER

Thank you for purchasing this product.
For optimum performance and safety, please
read these instructions carefully before connecting, operating or
- adjusting this product. Please keep this manual for future reference.

This product is 100% inspected and tested in the United States to verify
HDMI performance parameters.

WARNING

Do not expose this unit to water, moisture, or

excessive humidity.

Do not install or place this unit in a built-in
cabinet, or other confined space without
adequate ventilation.

To prevent risk of electrical shock or fire
hazard, due to overheating do not obstruct
unit's ventilation openings.

Do not install near any source of heat,
including other units that may produce heat.

Do not place unit near flames.
Only clean unit with a dry cloth.

7.

8.

Unplug unit during lightening storms or when
not used for an extended period of time. A
surge protector is strongly recommended.

Pratect the power cord from being walked on
or pinched, particularly at the plugs.

Use unit only with accessories specified by
the manufacturer.

10. Refer all servicing to qualified personnel.

CAUTION

HDMI is a very complex technology requiring continuous authentication of the signal and the same
video resolution and audio settings on all electronic equipment in the system. \When there are multiple
sources and displays, the video resolution and audio setting on all connected units must be adjusted
to correspond with that of the display having the lowest video and audio capability.
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INTRODUCTION

The Evolution by Vanco EVMX44VW 4K 4x4 Matrix Switcher with Video Wall capability, allows 4 HDMI sources to be
distributed up to 4 displays with full switching flexibility. The EVMX44VW features the ability of passing 4K@B0Hz resolution
and 4.4:4 Chroma Subsampling. Capable of 4 display video wall configurations, with ability for 180 degree screen rotation, as
well as bezel adjustments. The EVMX44V\W also has a scaling function, to achieve a variety of different resolution formats.
Multiple audio options including the ability to connect up to four audio sources and distribute up to four zones, with both
analog and digital outputs. The audio sources can also be utilized to embed audio onto the HDMI outputs. With the ability to
control switching via front panel selections, IR, RS-232, and TCP/IP. Simply connect the matrix unit to the local network, and
the switching can be controlled with any computer, tablet, and/or mobile device on the same network. An easy and intuitive
user interface allows for full control. For a 2x2 video wall application, and the ability to switch to a matrix function where each
display shows a different source, plus audio options, the EVMX44V\W is the perfect solution.

4K 4x4 Seamless Audio and Video Matrix with Video Wall
Part # EVMX44V\W

® 4K 4x4 Matrix with Video Wall Modes

® Supports up to 4K@B0Hz and 4:4:4 chroma subsampling

® Features resolution scaling with multiple formats available

® Supports up to a 4 display video wall

® Supports 180° screen rotation and bezel adjustments

® |ncludes built-in audio matrix to distribute up to four zones with analog and digital outputs
® Able to embed audio onto HDMI outputs

® |R pass-through to control sources from display locations

® Controllable via front panel, IR, RS-232 and TCP/IP

® Easy and intuitive User Interface to control switching and video wall functions via IP
e HDMI 2.0 and HDCP 2.2 compliant

® Rack mountable design

® Dimensions: 17" W x 8.7" D x 1.7" H (430mm x 220mm x 44mm)

PACKAGE CONTENTS

® (1) EVMX44VW 4K 4x4 Matrix Switcher ® (1) VAD9113X Toslink (Female) to 3.5mm
e (1) IR Remote Stereo (Male) Adapter

® (4] IR Receivers ® (1) AC Power Cord

® (4) IR Emitters ® (1) Product Manual

® (5) 3-pin Phoenix Connectors

® (4) 5-pin Phoenix Connectors
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SPECIFICATIONS

HDMI CompliaNCe .......cccovvviiiiiiieiiiiiccceeeee e HDMI 2.0

HDCP CompliaNCe ... ...ccovvvieiiiiieeiiieeeeeeee e HDCP 2.2

Video Bandwidth .... 18 Gbps

Video ReSolUtion .........c..ooviviieiiiicciccccecee Up to 4K@60Hz, 4:4:4 Chroma Subsampling
COIOP SPACE ... RGB, YChCr 4:4:4/4:2:2

HDMIAMPIEUE ... T.M.D.S +/- 0.4Vpp

Differntial IMpedance.............ococcooviiiiiiiiiiic 100+150hm

ESD Protection ..........cooviviiiiiiiiiiiiiiice Human-body Model:

+8KkV (Air-gap discharge) , +4kV (Contact discharge)

Baud Rate and Protocol..............cooviviviiiiiiiiccic Baud rate: 9600, data bit: 8 Stop bit: 1, no parity
checking

EERBINEE .o IE10.0+,HTMLS

HOUSING ..o Metal Enclosure

B0I0P L Black

DIMENSIONS ... 17" W x 8.7" D x 1.7" H (430mmx220mm=x44mm)
WEIGHE ... 11 Ibs

Power SUPPIY ....oveiiiccc AC 110-240V

Power Consumption .........c.coooiivieiiiiiei e B60W (Max)

Operating TeMPErature..........cc..ceevveeeeiieeeeiieeeiiee 0°C ~ 40°C / 32°F ~ 104°F

Storage TEMPErature ............coovvveieiiireeiiiieeeiieeeeinea -20°C ~ 70°C / -4°F ~ 158°F

Relative HUMIIBY ........ccoooiiiiiiiiic 10%~50% RH (non-condensing)
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10.
11.

12.
13.
14.

PANEL DESCRIPTIONS

Front Panel

Em ution

|| -

LCD Panel: Displays current status
COM: llluminates when matrix switcher is powered on
IR: IR Sensor to control the unit via included IR remote
LOCK: Locks/Unlocks front panel buttons (hold for 3 seconds to activate)
OUTPUT: Outputs 1-4 for output display selection
INPUT: Inputs 1-4 for input source selection
ALL: Set all outputs to the same input by pressing ALL+ INPUT # + TAKE
RES: Set the output scaler resolution based on the table on page 6
Press RES + OUTPUT # + NEXT (to toggle through options) + TAKE
EDID: Set the EDID options for the input selected based on the table on page 6
Press EDID + INPUT + NEXT + TAKE, change the EDID mode of part INPUT
NEXT: Select the next available option within a menu

SAVE: Save the current matrix setting as a preset by pressing SAVE + Output #(s). Up to 8 presets can
be saved.

RECALL: Set the matrix to a previously saved preset by pressing: RECALL+OUTPUT #(s)
CLEAR: Cancel the current command function
ENTER: Set the displayed option or command function
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RESOLUTION

Set the output scaler resolution based on the below table

Output Resolution Setting

Output Resolution Setting

3840x2160p 60Hz

1440x1050 B0Hz

3840x2160p 50Hz

1366x768 60Hz

3840x2160p 30Hz

1360x768 60Hz

3840x2160p 25Hz

1280x1024 60Hz

1920x1200 60Hz

1280x768 60Hz

1920x1080p 60Hz

1280x720p 60Hz

1920x1080p 50Hz

1280x720p 50Hz

1600x1200 60Hz

EDID

Set the EDID options for the input selected based on the below table

Output Resolution Setting

1024x768 60Hz

Output Resolution Setting

Manual

1920x1080 60Hz

3840x2160 60Hz

1280x1024 60Hz

3840x2160 30Hz

1280x720p 60Hz

1920x1200 60Hz

1024x768 60Hz
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PANEL DESCRIPTIONS

10.
1.

LAN: Connect to a local network such as a router or ethernet switch to give the matrix unit connectivity,
this will give the ahility to control the matrix unit via IP with any device on the network such as a
computer, tablet, or mohile phone

RS232: Connect the included RS-232 cable to a computer or 3rd party control system for integration

IR OUT - 1-4: Connect the included IR Transmitters (TXs) to each port, the number on the IR output
corresponds to the HDMI inputs (Connect this if you would like to control the sources from each display
location)

IR IN - 1-4: Connect the included IR Receivers (RXs) to each port, the number on the IR input
corresponds to the HDMI outputs (Place each IR RX at the corresponding display locations)

AUD INPUT — Connect audio sources via analog audio inputs to be routed and/or embedded onto HDMI
Outputs

AUD OUTPUT: Connect up to four zones via analog and Toslink audio outputs to be extracted or routed to
external audio components

INPUT: Connect HDMI sources to each corresponding HDMI input
OUTPUT: Connect HDMI display(s)

POWER SWITCH: Master switch to turn on/off power

POWER CONNECTOR: Connect the included power cord for power
GROUND: (Optional) connect to ground
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CONNECT AND OPERATE

IR Emitter Source Amplifier

Source

IR Receiver a IR Do s : ] IR Receiver

Connect your sources such as a Blu-Ray Player, game console, A/V Receiver, Cable or Satellite Receiver,
etc. to either the HDMI inputs on the unit. Insert and extract cables carefully with the power switched
off. Connecting and disconnecting while the unit is powered can result in damage to circuitry

Connect the HDOMI outputs that go to the displays

OPTIONAL: Connect the provided IR RX and IR TX cables if you wish to use IR routing. See below for
additional detailed information

OPTIONAL: Connect an Ethernet cable from the TCP/IP port on the matrix to a local Area Network, or
the provided R5232 cable with 3-pin phoenix connector to the RS232 port on the matrix

OPTIONAL: Connect audio inputs or outputs using the provided phoenix connector to embed, de-embed,
and route audio. See instructions in the AUDIO MATRIX section of the manual for additional information

Connect the power cable to the power receptacle on the matrix
Connect power supply to an available electrical outlet and power on the device to test
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IR CONTROL

The EVMX44VW allows for IR pass-through to control the connected sources at the display locations. The IR
signals are routed, so the sources are only controllable at a display location if the source is switched to that
output.

IR Emitters:

Connect the IR Emitters (Blasters/TXs) to the “IR OUT” port on the back of the matrix unit, ensure that the IR
Emitter is placed on the corresponding source (For example, IR OUT port 1 = HDMI input 1)

IR Receivers:

Connect the IR Receivers (RXs) to the “IR IN” port on the back of the matrix unit, ensure that the IR Receiver
is routed to the corresponding display (For example, IR IN port 1 — HDMI output 1)

IR Blaster
IR Blaster Signal

Power

—.eNC

IR Receiver
IR Signal

Power

C——© Grounding

NQOTE: Infrared receiving areas of source devices can be located by shining a flashlight onto the front of the
device — the sensor should be able to be seen through the plastic as a small, round object inside. Place the IR
Emitters around or near this area with the tip of the IR emitter near the IR sensor of the source. IR receivers
should be placed at the display and line of sight, so that an IR remote can be pointed at the pigtail to receive
IR signals.
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AUDIO MATRIX

In addition to an HDMI video distribution system, the EVMX44VW also includes a built-in audio matrix, where
audio sources can be connected and be sent up to four individual zones.

The 4 sets of Audio output (LR and Toslink) channels can be independent of video and switched by the User
Interface via TCP/IP. Audio Outputs utilize 5-pin Phoenix connectors to output balanced LR audio, and 4 mini
Toslink jacks to output analog LR audio and digital audio.

There are also 4 sets of analog audio inputs using 3-pin Phoenix connectors to input external analog LR audio,
this can also be used to embed audio onto the HDMI outputs.

RS-232/LAN CONTROL
CONNECTION

Network Control Connection

The product also supports Network control. Connect the LAN port of the matrix to a PC via a UTP (Cat5e/6)
cable, as shown in the following figure:

Note: Factory default network setting:

i tpe

Static IP 192.168. 0 .247

Subnet Mask  255.255.255. 0

Gateway 192.168. 0 . 1
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EVMX44avwW SOFTWARE

Befare running the software which can be downloaded on the product page on www.vanco.com, the password
is needed to log in.

Default password of Administrator (access to all features): 111111
Default password of User (access to all features, except OSD function): 000000

Connect with PC Tool

Matrix Switch | advanced Switch | Signal Setting | FineTune2Q | Video Wall| CEC Control | Network Setting | UART Seting | Engich v

Ausdio Only Unavailable: Switch Mode @ Follow Video ) Marsal

Aliset | Inputl > Recal Model = SaveAs Model  ~ koo
€ Mode :
GUBRT O Network Port (COM3 v Stats Disconnected Keset Reading...
: = Reading: Matrix Size dud success
Reading: Matrix Route success
Device Name 1P Address MAC Address Version
Reading: Screen Combine success
Reading: All Informasion success!
Nates Pleace WAIT unit oll info reading success!

Select UART (with RS-232 cable) or Network to connect
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Matrix Switch Page

Matrix Switch | Advanced Switch | Signal Setting | FineTuneQ | Video Wall | CEC Control | Network Setting | UART Setting | Engish v

Audio Only Unsvelable|  Switch Mode & Follow Video ) Manual

e 9O

Cirl Mode

O UART Nework Pom [cOM3 =] Stms
. . Reading: Matrix Size 4xé success
Device Nome 1P Address MAC Address Version Roading: Mot Route sccess
bt Reading: Screen Combine success
Reading: All Information success!

Note: Please WAIT unitl all info reading success

To switch one input port to all output ports, use the All set dropdown menu. For example, to switch input 1 to
all outputs:

Allset

Input2

Recall mode: Recall a preset of inputs/outputs (maximum of 8 presets)
2. Save mode: Save the current input/output mapping to create a preset

Note: Save/Recall button here works the same with front panel save/recall control, and also the same
with Save/Load function on video wall page

3. System reset: Resets the matrix to factory settings
Audio Switch mode: Follow Video mode or Manual mode
- When selecting Manual mode, separately switch L/R (Phoenix interface) and Toslink output(s)
- Can also select to use HDMI embedded or corresponding external LR audio

5. EDID Control: Click the “EDID” button on Matrix Switch page, there will be a pop-up EDID control window.
The following operations are:

a. Read EDID of one output port
b. Open one existing EDID file
c. Write EDID to one input port
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Advanced Switch Page

Matrix Switch Advanced Switch | Signal Setting | FineTune:PQ | OSD CTRL | Video Wall | CEC Control | Network Setting |

Usage note: 1. Add input to output 2. Tick output and then start sending loop

Input Custom name Output Custom name  Input Signal @ Send cmd periodly at ms
Input 1 - [ Output 1 Video-Outputl [Tal ot sand eambied
Input 2 - [JOutput 2  Video-Output2 S — 0
ot 3 i O vt 3 Vidoo Outputs ait others finished then start next loop
Input 4 - O Output 4  Video-Outputd

[JSend cmd only one loop

[Select all outputs:

[Cser ]
@

Stop.

The Advanced Switch page will repeatedly send a batch of matrix selection commands at the interval specified
in the Send cmd periodly at text.

Select one or more outputs
Select one input
Use the arrow button “-->" to assign that input to the selected output or outputs

After completing all required selections, click the “Start” button to run the commands

Ea T

The available options are:

All outputs send combined — Combine all outputs that have the same input number as a single command

Wait others finished the start next loop — \Wait for all commands in the previous pass to complete
before sending the next batch of commands.

Send cmd only one loop - Only send a single batch of commands
Select all outputs - Select all outputs when the option is checked
Start — Begin the command cycles

Stop — Stop the command cycles
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Signal Setting Page

Matrix Switchl Advanced Switch Signal Setting IFineTune‘ I TVWaIII Network Setting

—Input Board—| Read All 9
Label Input Type Input Format Audio Select | Output Type Output Format
1 [uHD-HD? ¥)[NoSignal  |[auto | |[uHD-HD? ¥] [ax2Ko30 v
2 [uHD-HD! ¥/ [No Signal |[asto  ~] |[uHD-HD ~] [ax2K030 v| [Read
3 [(uHD-HDI ¥/ [No Signal | (Ao ] |[uHD-HD! ~] [ak2x030 -
4 [uHD-HD! v)[No Signal  |[Auto  ~] |(uHD-HDI ¥/ 4K2K30 -

Audio Select: there are two options for input Audio Select

a) Auto: If the input source is HDMI signal, system will get the embedded audio; if the input source is
DVI signal, the system will get the corresponding analog audio

b) External: System will get the corresponding analog audio

Output Type: there are four options for output type:

1. UHD-HDMI (HDCP OFF)
2. UHD-DVI

3. UHD-HDCP-1.4

4. UHD-HDCP-2.2

Output Format: Set the output scaler resolution based on the chart below

Output Resolution Setting

Number

Output Resolution Setting

3840x2160p 60Hz

9

1440x1050 B0Hz

3840x2160p 50Hz

10

1366x768 60Hz

3840x2160p 30Hz

"

1360x768 60Hz

3840x2160p 25Hz

12

1280x1024 B0Hz

1920x1200 60Hz

13

1280x768 60Hz

1920x1080p 60Hz

14

1280x720p 60Hz

1920x1080p 50Hz

15

1280x720p 50Hz

1600x1200 60Hz

16

1024x768 60Hz
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FineTune Page

Matrix Switch | Advanced Switch | Signal Setting FineTune:2Q. | 05D CTRL | Video Wall | CEC Control | Network Setting |

Select PQ FineTune Port- Outputl Select Position FineTune Port- Input1 v—_——
s = Road the input cource
ot 9 = =0 ;
Saturation ¥ ]
Sharpness ¥ ] e g : =
Cool Read #1 1 e
J o
-
D Reset
—J - Read | |Reset
S
] ] [
Reset ON OFF
— Tl [

Choose the display by selecting the Output number corresponding to the display
Then click the “Read” button. Adjust Brightness, Contrast, Saturation, and/or Sharpness as desired.

If the video image looks incorrect after adjustments, reset to default settings by clicking on the “Reset
button”
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Video Wall Page

The EVMX44VW can be utilized to setup a 2x2 (4 display) video wall with any source connected, and
furthermore can display multiple sources on the 2x2 video wall display.

Matrix Switchl Advanced Sw:'tchl Signal Sening] FineTune:PQ Video Wall lCEC Controll Network Seth'ng]

—  VideoWall Setting  —F— Video Wall
Rows 2 ]
Columns 2 L Screen 1 Screen 2
Available 4 v
I Set ” Read I
Bezel Setting Screen 3 Screen 4
Type: @A OB
T
Right(Pixels) Screen Splicing
Tl [ || 2 3 Cancetspicing
Bottom(Pixels) :] Screen 4 - Cancel Splicing
Set Input Select >
Output Select >
Scene Save/Load Output Type >
I Save scene | | Load scene I Output Format >
Mirror >
Test Pattern >

Use the Video Wall Setting controls to change how the displays are arranged on the Video Wall page:

a. Adjust the Rows and Columns sliders to change the displayed screen arrangement to permit proper
Drag-and-Select of the desired screens for the video wall

b. Change the Available slider to set how many outputs will be used for the Video Wall
c. Click “Set” to change the Screen configuration

Use the left mouse button to drag-select the screens that will be set for video wall mode. The selected
screens will be shown as bright blue.

Use the right mouse button to open a menu.

Select “Screen Splicing” from the menu to program the video wall mode. The selected screens will now
be shown as bright green.

To change the displayed image: right-click to open the pop-up menu and select the desired input from the
“Input Select” menu option.

Repeating steps 2 ~ 5 above with a different set of outputs allows the creation of a second video wall.
However, changing the Rows, Columns and Available sliders will automatically delete the current video
wall set up when the “Set” button is clicked.
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Video Wall Page

The following example shows a more video wall set-up of two video walls with two 2x1 configurations:

Matrix Switch | Signal Setting | FineTune:pQ Video Wall |cec Control |

Scene Save/Load
’TSavesccne || Load scene |

Video Wall Context Menu

—  VideoWall Setting ~——— Video Wall
Rows 2 J
Columns 2 7
Available 4 o)

Set [ Read |

leeing Screend | Screen 4
Type: @A (OB
Left(Pixels) ]
Right(Pixels)
Top(Pixels) 1
BottomPixels) [ |
Set

Right clicking on any of the screen icons will display the following context menu:

Screen Splicing
Cancel Splicing

Screen 2 - Cancel Splicing

Input Select

Output Select
Output Type
Output Format

Mirror
Test Pattern
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Screen Splicing This option connects the selected screens into a video wall configuration

Cancel Splicing Return the Video Wall configuration to normal outputs
Screen x - Cancel Splicing 3840x2160p 30Hz

™

Wideo Wall disply with bizel compensation and
different full frams image on display 3

Input Select Use the sub-menu to select the input to display on the video wall or the secondary

input image shown in the above example

Output Select This option is only available for any screen that is not assigned to a video wall

mode

Output Type This option is only available for any screen that is not assigned to a video wall

mode

Output Format This option is only available for any screen that is not assigned to a video wall

mode. It allows setting of the output resolution for the selected screen output

Mirror Two sub options :
OFF ( default ), ON ( H+V Mirror)
When select “ON”, you can make 180° rotation with the selected screen

Test Pattern When Test Pattern is enabled, the output will display Color Bar pattern
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Bezel Setting

The Bezel Setting section allows the entry of values to compensate for the display bezel thickness. These
values may be entered either as pixels (Type A) or as mm (Type B).

Type A Bezel Settings

The image size will be adjusted to allow for the number of pixels entered in each of the entry boxes. Click the
“Set” button to view the effect of the new values.

Type B Bezel Settings

The image size will be adjusted to allow for the Inner and Outer display dimensions as entered in each of the
entry boxes. Click the “Set” button to view the effect of the new values.

Bezel Compensation

The following images demonstrate the effect of not having bezel compensation and what a correctly configured
bezel compensation settings should produce:

No Bezel Compensation Correct Bezel Compensation

Layout Save/Load

The Save Scene/Layout and Load Scene/Layout buttons allow a video wall configuration to be saved or recalled
at any time. Up to 10 configurations, each with their own name can be saved or recalled. When saving, each
Scene can optionally be given a name to identify that video wall scene setup.
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CEC Control Page

Matrix Switzh] Advanced Switch | Signal Setting | FineTune:PQ | Video Wall CEC Control | Network Setting

10 Poer on]

Input
Input1l [ Power ON
o
ot

Qutput
Output1 | Power ON | [ Power OFF | [ Volume+ | [ volume- | [Mute/unmute|
Output2 | Power ON | [ Power OFF | [ volume+ | [ volume- | [Mutepunmute|
Output2 | Power ON | [ Power OFF | [ Volume+ | [ Volume- | [MuteUnmute|
Output4 | Power ON | [ Power OFF | [ Volume+ | [ Volume- | [MutefUnmute|

If Auto Power On is enabled, every time when the product is turned on, it will turn on all the sources and
displays which are connected to it.

The product supports CEC function, including Power on/off, Volume+/-, Mute/Unmute.

Control via Web

The built-in Web GUI interface provides basic control of the matrix switcher and access to the network
settings. The default IP Address of a unit is 192.168.0.247. The following will be displayed when the web
interface is accessed each time:

Authentication Required

@ http://10.64.88.1 is requesting your username and password. The site says: "S2E”

X

User Name: ‘

Password: l

|

Cancel

The default User Name is: admin

The default Password is: admin

After entering the User Name and Password, an interface similar to the following will be displayed:
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Matrix Control control panel

i Audio *
Video eUR @UR @UR
OUT\IN d

1
o3
~4

A ENTPN Folow Video v
CEC

[SEINe Power ON J| Power OFF [SIESY Power ON | Power OFF § Volumn+ § Volumn- | Mute/Unmute

Output2 Power OFF Outpt Power ON || Power OFF J§ Volumn+ § Volumn- § Mute/Unmute

—
[ERRER Power ON § Power OFF 0 Power ON J| Power OFF J| Volumn+ § Volumn- § Mute/Unmute
BEEERY Power ON J| Power OFF EEETEY Pover ON J§ Power OFF J Volumn+ J§ Volumn- i Mute/Unmute

IP type
sta o+ Mo |
o+ Mo _H:
CEN 0NN A
| save § Cancel |

The IP Config tab is used to change the IP settings of the matrix switcher. Enter any necessary changes and
click “Save” to program the switcher to the new settings or click “Cancel” to reject the changes.
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LIMITED WARRANTY

With the exceptions noted in the next paragraph, Vanco warrants to the original purchaser that the equipment
it manufactures or sells will be free from defects in materials and workmanship for a period of two years from
the date of purchase. Should this product, in Vanco’s opinion, prove defective within this warranty period,
Vanco, at its option, will repair or replace this product without charge. Any defective parts replaced become
the property of Vanco. This warranty does not apply to those products which have been damaged due to
accident, unauthorized alterations, improper repair, modifications, inadequate maintenance and care, or use in
any manner for which the product was not originally intended.

Items integrated into Vanco products that are made by other manufacturers, notably computer hard

drives and liquid crystal display panels, are limited to the term of the warranty offered by the respective
manufacturers. Such specific warranties are available upon request to Vanco. A surge protector, power
conditioner unit, or an uninterruptible power supply must be installed in the electrical circuit to protect against
power surges.

If repairs are needed during the warranty period the purchaser will be required to provide a sales receipt/sales
invoice or other acceptable proof of purchase to the seller of this equipment. The seller will then contact Vanco
regarding warranty repair or replacement.
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TECHNICAL SUPPORT

In case of problems, please contact Vanco Technical Support by dialing 1-800-626-6445. You can also email
technical support issues to techsupport@vanco1.com.

When calling, please have the Model Number, Serial Number (affixed to the bottom of the unit) and Invoice
available for reference during the call.

Please read this Instruction Manual prior to calling or installing this unit, since it will familiarize you with the
capahilities of this product and its proper installation.

All active electronic products are 100% inspected and tested to insure highest product quality and trouble-
free installation and operation. The testing process utilizes the types of high-definition sources and displays
typically installed for entertainment and home theater applications.

For additional information, such as helpful installation videos, etc. please visit www.vancol.com

LIABILITY STATEMENT

Every effort has been made to ensure that this product is free of defects. The manufacturer of this product
cannat be held liable for the use of this hardware or any direct or indirect consequential damages arising
from its use. It is the responsibility of the user and installer of the hardware to check that it is suitable for
their requirements and that it is installed correctly. All rights are reserved. No parts of this manual may be
reproduced or transmitted by any form or means electronic or mechanical, including photocopying, recording
or by any information storage or retrieval system without the written consent of the publisher.

Manufacturer reserves the right to revise any of its hardware and software following its policy to modify and/or
improve its products where necessary or desirable. This statement does not affect the legal rights of the user
in any way.
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Vanco® International
506 Kingsland Drive

Batavia, Illinois 60510

call: 800.626.6445

fax: 630.879.9189

visit: www.vanco1.com



